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管理ソフトウェアの FAQ

この章では、Cisco Fabric Manager および Device Manager に関する主な FAQ について回答します。

この章の内容は、次のとおりです。

• 「インストールの問題」（P.12-3）

– 「Windows で Fabric Manager をインストールするとき、[Install] をクリックしてもインストー

ルされません」（P.12-3）

– 「Solaris 上で Fabric Manager を起動できません」（P.12-3）

– 「ブラウザ上に JNLP ファイルの保存を促すプロンプトが表示されます」（P.12-4）

– 「[Java Web Start not detected] エラーが表示されます」（P.12-4）

– 「デスクトップ ショートカットが表示されません」（P.12-4）

– 「Fabric Manager または Device Manager を新しいバージョンにアップグレードする方法を教

えてください」（P.12-4）

– 「Fabric Manager または Device Manager をダウングレードする方法を教えてください」

（P.12-5）

– 「アップグレードできません」（P.12-5）

– 「ダウンロード ダイアログで Java Web Start が停止します」（P.12-5）

– 「Java Web Start を手動で設定する方法を教えてください」（P.12-5）

– 「Java Web Start をコマンドラインから実行する方法を教えてください」（P.12-6）

– 「Java Web Start のキャッシュをクリアする方法を教えてください」（P.12-6）

– 「Fabric Manager または Device Manager にログインできません」（P.12-6）

– 「pcAnyWhere の実行中に Fabric Manager または Device Manager をインストールできません。

または Java を実行できません」（P.12-7）

– 「[Services] メニューで、Fabric Manager または Performance Manager サービスが [disabled] 
と表示されます」（P.12-7）

– 「McAfee Internet Suite 6.0 Professional の実行中に Fabric Manager または Device Manager を
インストールできません。または Java を実行できません」（P.12-7）

• 「全般」（P.12-7）

– 「面グラフのモニタ中にエラーが表示されます」（P.12-7）

– 「[gen error] メッセージが表示されます」（P.12-8）

– 「Device Manager Summary View にディスク イメージが表示されません」（P.12-8）

– 「Device Manager に D_S_TOV および E_D_TOV タイマーを同時に設定できません」（P.12-8）
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– 「Device Manager テーブルのカラムを大きくする方法を教えてください」（P.12-8）

– 「ファブリックの変更がマップに伝播されません（リンクが消えない、など）」（P.12-8）

– 「PortChannel の作成ダイアログボックスを何度か使用したら小さくなってしまいました」

（P.12-8）

– 「IPFC を設定するとエラーが表示されます」（P.12-9）

– 「Fabric Manager または Device Manager で正しいネットワーク インターフェイスが使用され

ません」（P.12-9）

– 「Fabric Manager または Device Manager の画面が正常に表示されません」（P.12-9）

– 「編集ゾーン内のアクティブ ゾーン セットが（正しくアクティブ化した場合でも）太字で表示

されます」（P.12-10）

– 「プレフィクスが IVRZ のゾーンまたは nozonset という名前のゾーン セットを作成できます

か」（P.12-10）

– 「ワンクリック ライセンス インストールが実行されず、シスコの Web サイトにもアクセスで

きません」（P.12-10）

– 「Fabric Manager Client および Device Manager をスイッチに接続できません」（P.12-10）

– 「Fabric Manager Client のログ ウィンドウ サイズを大きくする方法を教えてください」

（P.12-10）

– 「FM Server Database が起動できません。またはファイル ロック エラーが発生します」

（P.12-11）

• 「Windows の問題」（P.12-11）

– 「表示されたテキスト フィールドが小さすぎてデータを入力できません」（P.12-11）

– 「印刷するとアプリケーションがクラッシュします」（P.12-11）

– 「Windows XP が停止しました（ブルー画面になりました）」（P.12-12）

– 「Fabric Manager および Device Manager アイコンが表示されません」（P.12-12）

– 「Windows XP で Device Manager または Fabric Manager ウィンドウの内容が表示されません」

（P.12-12）

– 「ファイルをローカル マシンからスイッチにコピーすると SCP/SFTP にエラーが発生します」

（P.12-12）

• 「UNIX の問題」（P.12-12）

– 「親メニューが表示されません」（P.12-12）

– 「Web サーバは稼動しているのにブラウザで検出できません」（P.12-13）

– 「[too many open files] エラーへの対処方法を教えてください」（P.12-13）

• 「その他」（P.12-13）

– 「Fabric Manager の再起動後もマップ レイアウトを保持する方法を教えてください」

（P.12-13）

– 「スイッチは 1 台しかないのにマップには 2 つ表示されます」（P.12-14）

– 「スイッチ内のレッド /オレンジ /点線の意味を教えてください」（P.12-14）

– 「マップ設定を保持したままアップグレードする方法を教えてください」（P.12-20）

– 「Fabric Manager Server を新規ホストに移行するときに履歴データを保持する方法を教えてく

ださい」（P.12-20）

– 「FCIP で Fabric Manager を使用する場合の制約事項はありますか」（P.12-20）
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インストールの問題
– 「[Please insure that FM server is running on localhost] メッセージへの対処法を教えてくださ

い」（P.12-21）

– 「複数のインターフェイスを使用して Cisco Fabric Manager を実行する方法を教えてください」

（P.12-21）

– 「HTTP プロキシ サーバの設定方法を教えてください」（P.12-22）

– 「トポロジ マップをクリアする方法を教えてください」（P.12-23）

– 「ソフトウェア混在環境での Fabric Manager の使い方を教えてください」（P.12-23）

– 「Fabric Manager 起動時に「corrupted jar file」エラーが表示されます。対処方法を教えてくだ

さい」（P.12-23）

– 「ファブリック内のデバイスの検索方法を教えてください」（P.12-24）

– 「Fabric Manager Server のライセンスについて教えてください」（P.12-25）

– 「複数のファブリックの管理方法を教えてください」（P.12-26）

– 「ライセンス期限が切れるとスイッチに表示されるオレンジの X をクリアする方法を教えてく

ださい」（P.12-26）

インストールの問題

Windows で Fabric Manager をインストールするとき、[Install] をク
リックしてもインストールされません

Java Web Start が正しくインストールされていることを確認してください。確認する手順は、次のとお

りです。

ステップ 1 [Programs] メニューを開き、Java Web Start が表示されているかどうかを確認します。

ステップ 2 Java Web Start プログラムを起動して、Java Runtime のインストールに問題がないか確認します。

ステップ 3 [Preferences] タブをクリックし、Web Start のプロキシ設定が適切かどうかを確認します。

ステップ 4 JNLP 設定を適切に処理するようにブラウザが設定されているか確認します（「Java Web Start を手動で

設定する方法を教えてください」（P.12-5）を参照）。

旧バージョンのアプリケーションを実行し、（エラーの詳細に）JNLP ファイルを開くことができない

ことを示すエラー ポップアップ ウィンドウが表示された場合、Java Web Start のキャッシュが破損し

ている可能性があります。この問題を解決するには、キャッシュをクリアして、再試行してください。

キャッシュをクリアする手順については、「Java Web Start のキャッシュをクリアする方法を教えてく

ださい」（P.12-6）を参照してください。

Solaris 上で Fabric Manager を起動できません

Solaris 2.8 を使用し、ルートとしてログインしているユーザが、Netscape Navigator 6 を使用している

場合は、MIME タイプを登録できません。正規ユーザが Netscape Navigator 6 に MIME タイプを登録

するには、手動で追加する必要があります。Netscape 4.x は、すべてのユーザに対して適切に機能しま

す。
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ブラウザ上に JNLP ファイルの保存を促すプロンプトが表示されます

JNLP MIME タイプに対応した Java Web Start を起動するようにブラウザが設定されていない可能性が

あります。Java Web Start が適切にインストールされていないか、適切に設定されていません（「Java 
Web Start を手動で設定する方法を教えてください」（P.12-5）を参照）。

[Java Web Start not detected] エラーが表示されます

Java Web Start をインストールしたにもかかわらず、スイッチのホーム ページに [Java Web Start not 
detected...] というエラー メッセージが（赤色で）表示される場合は、単純な JavaScript エラーの可能

性があります。Java Web Start インストールを検出するために、Internet Explorer および Mozilla（新

しいバージョン）でテストされた JavaScript コードが実行されています。一部のブラウザ（Netscape 
6.0 や Opera など）では、リンクが機能していても、このコードが正しく機能しないことがあります。

• まず、インストール リンクをクリックしてください。

• それでもエラーが表示される場合は、ブラウザのヘルパー アプリケーションが正しく設定されて

いるかどうかを確認してください（Netscape 6.0 の場合は [Edit] > [Preferences] > [Navigator] > 
[Helper Applications] をクリックします）。「Java Web Start を手動で設定する方法を教えてくださ

い」（P.12-5）を参照してください。

デスクトップ ショートカットが表示されません

Windows 2000 および Windows NT の場合は、Fabric Manager および Device Manager のプログラム 
メニュー エントリ（新規 Cisco MDS 9000 プログラム メニューの下）、およびデスクトップ ショート

カットが作成されます。Manager および Device Manager のデスクトップ ショートカットおよびスター

ト メニュー エントリの名前は、それぞれ [FabricManager] および [DeviceManager] です。Windows の
他のバージョン（XP など）では、FabricManager.bat および DeviceManager.bat というバッチ ファイ

ルがデスクトップに作成されます。UNIX の場合は、FabricManager.sh および DeviceManager.sh とい

う名前のシェル スクリプトが $HOME/.cisco_mds9000/bin ディレクトリに作成されます。Mozilla 
ベースの各ブラウザ上で稼動する Windows インストールの場合は、デスクトップ ショートカットが作

成されません。対処するには、手動でデスクトップ ショートカットを作成します。

Fabric Manager または Device Manager を新しいバージョンにアップグ
レードする方法を教えてください

Fabric Manager または Device Manager を新しいバージョンにアップグレードする手順は、次のとおり

です。

ステップ 1 稼動中の Fabric Manager または Device Manager のインスタンスをすべて閉じます。

ステップ 2 新規バージョンが稼動しているスイッチをブラウザで指定して、該当するインストール リンクをク

リックします。このスイッチで新規バージョンが稼動している場合は、アップグレードを求めるプロン

プトが表示されます。

インストーラがローカル コピーを調べて、新しいソフトウェア バージョンに更新します。
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Fabric Manager または Device Manager をダウングレードする方法を教
えてください

Cisco MDS NX-OS Release 4.xCisco MDS 以降、インストーラでは、ダウングレードをサポートしま

せん。Fabric Manager または Device Manager を旧リリースにダウングレードするには、手動でアンイ

ンストールしてから、前のバージョンの Fabric Manager または Device Manager をインストールする

必要があります。

アップグレードできません

Fabric Manager または Device Manager で、スイッチのバージョンの方が高いことを示すプロンプトが

表示されたために、アップグレードを試みて失敗した場合は、デフォルト ブラウザ設定が正しくない

可能性があります。最後のブラウザのアップグレードまたはインストール中に、何らかのエラーが発生

しています。対処するには、ブラウザを単独で起動して、インストールをクリックします。

まれに、アップグレードしてもバージョンが変化しないことがあります。これは、HTTP がネットワー

クにキャッシュされているためです。アップグレード中に、スイッチのファイルに対する HTTP 要求

がローカル マシンにキャッシュされます。スイッチのバージョンの方が高い場合でも、インストール

された管理ソフトウェアは古いバージョンのままです。対処するには、Fabric/Device Manager をアン

インストールして、Java Web Start キャッシュをクリアしてから、新規にインストールします。

ダウンロード ダイアログで Java Web Start が停止します

ブラウザの設定と同様に Java Web Start がスイッチにアクセスするように設定されているかどうかを確

認する手順は、次のとおりです。

ステップ 1 Java Web Start を起動します（javaws.exe または javaws）。Java Web Start Application Manager が表

示されます。

ステップ 2 [File] > [Preferences] > [General] を選択し、プロキシが正しく設定されているかどうかを確認します。

たとえば、HTTP プロキシを使用している場合、ここで設定します。

ステップ 3 [Use Browser] を選択します。

ステップ 4 [OK] をクリックします。

Java Web Start を手動で設定する方法を教えてください

Opera、特定のバージョンの Mozilla、または Konqueror などのブラウザでは、JNLP ファイルのヘル

パー アプリケーションとして Java Web Start を手動で登録する必要があります。このために必要な

データは、次のとおりです。

• 記述 = Java Web Start 

• ファイル拡張子 = jnlp 

• MIME タイプ = application/x-java-jnlp-file 

• アプリケーション = javaws のパス（/usr/local/javaws/javaws など） 
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この設定の完了後、ブラウザを再起動する必要があります。[Java Web Start not detected] という警告が

表示されても、無視してかまいません。これらの警告は JavaScript に基づいています。すべてのブラ

ウザが JavaScript と適切に連携するわけではありません。インストール リンクをクリックして、

Fabric Manager または Device Manager をインストールします。

（注） Windows ユーザの場合：*.jnlp ファイルに Java Web Start を設定するには、[Windows Explorer] > 
[Tools] > [Folder Options] > [File Types] を選択します。javaws.exe によって *.jnlp ファイルが開かれ

るように、JNLP の既存設定を変更するか、または設定を追加します。この実行ファイルは Program 
Files¥Java Web Start 内にあります。

Java Web Start をコマンドラインから実行する方法を教えてください

ブラウザから Java Web Start を実行できない場合でも、コマンドラインから Java Web Start
（javaws.exe または javaws）を実行できます。そのためには、スイッチ上の Fabric Manager または 
Device Manager の URL を引数として指定します。たとえば、スイッチの IP アドレスが 10.0.0.1 であ

る場合は、次のコマンドを使用して、Fabric Manager および Device Manager を起動します。

javaws http://10.0.0.1/cgi-bin/fabric-manager.jnlp
javaws http://10.0.0.1/cgi-bin/element-manager.jnlp

Java Web Start のキャッシュをクリアする方法を教えてください

Java Web Start のキャッシュをクリアする手順は、次のとおりです。

ステップ 1 Java Web Start Application Manager（javaws.exe または javaws）を起動します。

ステップ 2 [File] > [Preferences] > [Advanced] を選択し、アプリケーション フォルダまたはキャッシュをクリア

します。.javaws またはキャッシュ ディレクトリは手動で削除できます。Windows の場合、このディ

レクトリは [Documents and Settings] 内にあります。UNIX の場合は、$HOME 内にあります。

Fabric Manager のアップグレード中、ショートカットを作成するプロン
プトが表示されません

この章の「Java Web Start のキャッシュをクリアする方法を教えてください」の手順に従って Java 
Web Start の キャッシュをクリアします。

Fabric Manager または Device Manager にログインできません

スイッチ上で初期設定ルーチンが実行されているかどうかを確認します。『Cisco MDS 9000 Family 
Fabric Manager Fundamentals Configuration Guide』を参照してください。簡単に確認する手順は、

次のとおりです。

• スイッチの管理インターフェイスが起動しているかどうかを確認します（show interface 
mgmt0）。

• 管理インターフェイスに接続できるかどうかを調べます（ping）。
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• ユーザ名が有効かどうかを確認します（show snmp user）。CLI（コマンドライン インターフェイ

ス）からユーザを追加 /編集することもできます。

• ネットワーク インターフェイスが複数存在する場合は、「Fabric Manager または Device Manager 
で正しいネットワーク インターフェイスが使用されません」（P.12-9）を参照してください。

pcAnyWhere の実行中に Fabric Manager または Device Manager をイ
ンストールできません。または Java を実行できません

pcAnyWhere サービスを停止して Fabric Manager または Device Manager をインストールするか、ま

たは DirectX をインストール /更新してください。詳細については、http://java.sun.com/ の Web サイ

トを参照してください。

[Services] メニューで、Fabric Manager または Performance Manager 
サービスが [disabled] と表示されます

この状況は、次の場合に発生することがあります。

• アンインストール /アップグレード中に、Fabric Manager または Performance Manager の 
[Services] メニューが開いていた場合 

• アンインストール /アップグレード中に、Fabric Manager Client または Device Manager を実行し

ていた場合 

このエラーは、Windows がサービスを完全に削除できない場合に発生します。ホストを再起動すると、

問題が解決されます。

McAfee Internet Suite 6.0 Professional の実行中に Fabric Manager ま
たは Device Manager をインストールできません。または Java を実行で
きません

McAfee Internet Suite にはウィルス スキャナ、ファイアウォール、アンチスパム、およびプライバシ

管理機能が搭載されています。プライバシ管理機能によって、Fabric Manager Server と Client 間の相

互作用が妨げられることがあります。対処するには、プライバシ サービスを停止する必要があります。

全般

面グラフのモニタ中にエラーが表示されます

モニタ ウィンドウから面グラフを表示する場合、最初のデ－タが戻される前に面グラフ上でマウスを

移動すると、JChart getX() からのメッセージログに、java.lang.ArrayIndexOutOfBoundsException エ
ラーが表示されます。これは、JChart がまだ存在しない値の検索を試みたことが原因です。この問題

は、今後の JChart バージョンで修正される予定です。
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[gen error] メッセージが表示されます

通常、[gen error] は、SNMP（簡易ネットワーク管理プロトコル）要求の処理プロセスで、スイッチの 
SNMP エージェントに予期せぬエラーが発生したことを意味します。ただし、Virtual Private Network

（VPN; バーチャル プライベート ネットワーク）接続または任意の種類の Network Address Translation
（NAT; ネットワーク アドレス変換）方式を介してスイッチにアクセスしている場合は、すべてのエ

ラーが [gen error] として報告されます。これは既知の問題であり、今後のリリースで修正される予定

です。これが [gen error] の原因であるかどうかを調べるには、NAT が設定されていない環境でこのエ

ラーを再生成します（スイッチと同じネットワークで作業します）。

Device Manager Summary View にディスク イメージが表示されません

Device Manager の Summary View テーブルに、Fx ポートに接続されたディスクのアイコンが表示さ

れないことがあります。これは、このポートに FC4 機能が設定されていないためです。LUN 検出を発

行して、FC4 タイプが登録されていないホスト /ディスクに関する情報を検出する必要があります。こ

れには Device Manager で、[FC] > [Advanced] > [LUNs] をクリックしてください。

Device Manager に D_S_TOV および E_D_TOV タイマーを同時に設定
できません

E_D_TOV と D_S_TOV を両方同時に変更した場合、新しい D_S_TOV 値が古い E_D_TOV 値よりも

大きいと、WrongValue エラーが表示されます。対処するには、これらの値を個別に変更する必要があ

ります。

Device Manager テーブルのカラムを大きくする方法を教えてください

Device Manager が大型テーブルの表示を試みたとき、スイッチの実行が遅いと、テーブルが表示され

たときにタブが非表示になります。対処するには、データが表示されるようにウィンドウのサイズを変

更する必要があります。

ファブリックの変更がマップに伝播されません（リンクが消えない、など）

Fabric Manager では、ダウンしているデバイスまたはポート上にレッドの十字が表示されます。ただ

し、すでに検出された情報は自動的には削除されません。マップを正しく更新するには、再検出する必

要があります。

PortChannel の作成ダイアログボックスを何度か使用したら小さくなって
しまいました

MemberList TextBox（PortChannel の [Create] ウィンドウ内）を何度か使用すると、正しく表示され

なくなります。ポート選択用のコンボ ボックスが付いた長いテキスト ボックスが、小さな正方形のテ

キスト ボックスに変わり、小さすぎてポートを選択できなくなります。これは既知の問題であり、今

後のリリースで修正される予定です。この問題に対処するには、Fabric Manager または Device 
Manager を停止して再起動します。
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IPFC を設定するとエラーが表示されます

IPFC および帯域外管理が設定されていると、IPFC アドレスを使用した場合に、Device Manager と 
SNMPv3 が正しく動作しなくなることがあります。対処するには、管理インターフェイス（mgmt0）
アドレスを使用するか、または IPFC 上で SNMPv1/v2c を使用します。

Fabric Manager または Device Manager で正しいネットワーク インター
フェイスが使用されません

この問題の原因は、ローカル インターフェイスが基本的な Java ライブラリによって任意に選択される

ことです。対処するには、コマンドライン引数を指定してから、Fabric/Device Manager を起動しま

す。デスクトップ ショートカット、シェル スクリプト、またはバッチ ファイルに、パラメータ 
-Device Managerds.nmsAddress= を追加します。

たとえば、Windows では、この行は ..javaw.exe -Device Managerds.nmsAddress=X.X.X.X -cp .. のよ

うになります。

デスクトップ ショートカットでは、この長さが、許容される最大文字数を超えることがあります。そ

の場合は、-Dsun.java2d.ddoffscreen=false の部分を削除して、必要な文字数を確保します。新しい

バージョンの Fabric Manager（Release 1.2 以降）では、推奨ネットワーク インターフェイスを選択で

きます。

Fabric Manager または Device Manager の画面が正常に表示されません

Fabric Manager または Device Manager のメニューからサブメニューを表示した場合、Fabric Manager 
Map のマウス ポインタの速度が遅く、マウスの移動に反応できない場合、または不正なツールチップ

が表示された場合、画面が正常に表示されませんが、Fabric Manager または Device Manager に問題が

あるわけではありません。

一部の古いビデオ カードでは、これらの異常な表示が発生する場合があります。この問題を解決する

には、まずビデオ ドライバを更新します。それでも問題が解決しない場合は、ビデオ カードを交換し

ます。

[Physical Attributes] カテゴリがほとんど表示されなくなりました

拡張機能がオフになっています。Fabric Manager 画面の右上にある [Advanced Features] チェック ボッ

クスを確認してください。チェック ボックスをオンにします。

[Information] ペインが表示されません

通常、[Information] ペインは Fabric Manager のマップの上半分に表示されます。マップが重なってい

る可能性があります。マップ ウィンドウの端を下方向にドラッグするか、黒の三角をクリックして画

面を再表示します。
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編集ゾーン内のアクティブ ゾーン セットが（正しくアクティブ化した場合
でも）太字で表示されます

VSAN のメンバーが IVR ゾーニングに参加しています。アクティブ ゾーンに IVR ゾーンが追加された

ため、アクティブ ゾーン セットの設定が同名のローカル ゾーン セットの設定と異なります。この場

合、ゾーン セット名が常に太字になります。

プレフィクスが IVRZ のゾーンまたは nozonset という名前のゾーン セッ
トを作成できますか

これらの特殊な名前は使用しないでください。これらの名前は、IVR ゾーンを識別するためにシステ

ムで使用されます。

ワンクリック ライセンス インストールが実行されず、シスコの Web サイ
トにもアクセスできません

ワンクリック ライセンス インストールでは、シスコ Web サイトへの HTTP 接続を開こうとします。ブ

ラウザで HTTP プロキシを使用している場合には、Fabric Manager Client のスクリプトに次のコマン

ドライン変数を追加する必要があります。

-Dhttps.proxyHost and -Dhttps.proxyPort. 

ワンクリック インストールの URL が「https://」ではなく「http://」から開始する場合、変数は次のよ

うになります。

-Dhttp.proxyHost and -Dhttp.proxyPort.

たとえば、Windows の場合、MDS 9000¥bin¥FabricManager.bat ファイルを編集し、JVMARGS に
「-Dhttps.proxyHost=HOSTADDRESS -Dhttps.proxyPort=HOSTPORT」を追加します。

Fabric Manager Client および Device Manager をスイッチに接続できま
せん

Cisco MDS SAN-OS Release 1.3(3) 以前で SNMPv3 を使用している Fabric Manager または Device 
Manager は、Release 1.3(4) 以降を実行しているスイッチを管理できません。これは、Fabric Manager 
で Release 1.3(3) から Release 1.3(4) にソフトウェアをアップグレードする場合に影響することがあり

ます。

Fabric Manager Client のログ ウィンドウ サイズを大きくする方法を教え
てください

FM Client によるメモリ消費を制限するために、ログ ウィンドウはデフォルトで 500 行に制限されてい

ます。このサイズを拡大するには、<install directory>/db/<user> ディレクトリの sm.properties を編集

し、LogBufferSize を変更します。
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Windows の問題
FM Server Database が起動できません。またはファイル ロック エラーが
発生します

データベース ログ（FMPersist.log）に [The database is already in use by another process] というエラー 
メッセージが表示されます。HsqlDB 1.7.1 バージョンにこの問題があります。ファイル ロックはたま

に発生しますが、db サーバをシャットダウンして再起動すると解決できます。Windows の場合は 
FMPersist サービスを停止して起動します。Unix の場合は FMPersist.sh スクリプトの引数を restart に
して実行します。

Fabric Manager Client を Fabric Manager Server と再同期する方法を
教えてください

場合によっては、Fabric Manager Client が Fabric Manager Server と非同期でクライアントとサーバの

再同期が必要です。Fabrix Manager Client と Fabric Manager Server を再同期するには、[File] メ
ニューから [Resync All Open Fabrics] を選択します。

現在のファブリックを再検出する方法を教えてください

Fabric Manager Server がファブリックのスイッチと非同期の場合、オンデマンド検出を実行してファ

ブリックのスイッチの変更を Fabric Manager Client で最新の状態にする必要があります。ファブリッ

ク スイッチを再検出するには、[File] メニューから [Rediscover] を選択します。

SCSI ターゲットを再検出する方法を教えてください

Fabric Manager Server が SCSI ターゲットと非同期の場合、オンデマンド検出を実行してファブリック

のスイッチの変更を Fabric Manager Client で最新の状態にする必要があります。ファブリック スイッ

チを再検出するには、[File] メニューから [Rediscover SCSI Targets] を選択します。

Windows の問題

表示されたテキスト フィールドが小さすぎてデータを入力できません

Reflection X を実行している場合、Fabric Manager および Device Manager の特定のテキスト フィール

ドが完全な幅で表示されません。フィールドを適切に表示できるように、ダイアログボックスのサイズ

を変更してください。

印刷するとアプリケーションがクラッシュします

Windows NT には、既知の Sun JVM バグがあります（印刷サービスを実行すると VM がクラッシュし

ます）。Sun が提案するソリューションは、NT を SP 6 に更新することです。詳細については、次の 
URL を参照してください。

http://developer.java.sun.com/developer/bugParade/bugs/4530428.html
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UNIX の問題
Windows XP が停止しました（ブルー画面になりました）

Windows XP と ATI Radeon AGP グラフィック カードを併用している場合、Java アプリケーションを

終了すると、フリーズ（停止）します。ATI の新しいドライバを使用すると、この問題が解決されるよ

うです。その他の対応策は、「-Dsun.java2d.noddraw=true」を指定してアプリケーションを実行するこ

とです。ショートカットおよびシェル スクリプトの作成時に、現在この方法が使用されています。詳

細については、次の URL を参照してください。
http://developer.java.sun.com/developer/bugParade/bugs/4713003.html

Fabric Manager および Device Manager アイコンが表示されません

Windows のバージョンによっては、特定のイメージが表示されません。これは Java のバグです。対応

策（DirectDraw アクセラレーションのディセーブル化）を講じていますが、それでもこの問題が発生

する場合があります。詳細については、次の URL を参照してください。
http://developer.java.sun.com/developer/bugParade/bugs/4664818.html

Windows XP で Device Manager または Fabric Manager ウィンドウの
内容が表示されません

Windows XP で Device Manager または Fabric Manager のメイン ウィンドウの内容が表示されないの

は、Java のバグが原因です。次の Web サイトを参照してください。
 http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=4919780 

 ウィンドウの内容を復元するには、ウィンドウを最小化または最大化してから標準サイズに戻します。

<FM-install-dir>/bin/FabricManager.bat および DeviceManager.bat の JVMARGS に
「-Dsun.java2d.noddraw=true」を追加し、Direct Draw をディセーブルにしても、この問題を防ぐこと

ができます。

ファイルをローカル マシンからスイッチにコピーすると SCP/SFTP にエ
ラーが発生します

ファイル パスにスペースが含まれていると、Windows の SCP/SFTP にエラーが発生します。スイッチ

から copyDeviceBusy エラーが返されます。License Wizard などのツールでは、tftp コピーが実行可能

であることを確認するか、またはスペースを含まないファイル名を選択します。

UNIX の問題

親メニューが表示されません

サブメニューを表示すると、親メニューが表示されなくなることがあります。このバグの詳細について

は、次の URL を参照してください。
http://developer.java.sun.com/developer/bugParade/bugs/4470374.html 
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Web サーバは稼動しているのにブラウザで検出できません

ブラウザでプロキシ サーバを使用しているときに発生します。ブラウザでプロキシ サーバを使用して

いるかどうかを確認するには、Internet Explorer の場合は、メニューから [Tools] を選択し、[Internet 
Options]、[Connection] サブパネルの順に指定して [Lan Setting] をクリックします。ダイアログボッ

クスが表示されます。プロキシの設定を確認します。

[too many open files] エラーへの対処方法を教えてください

Linux で Java Virtual Machine（JVM）が稼動していて、Java がインストールされたドライブまたは

ホーム ディレクトリが NFS マウントの場合、ファイル ロックの取得エラーに関する Sun JDK の既知

のバグがあります。Fabric Manager の症状として、Device Manager の起動またはファイルの保存 /
オープンに失敗し、[too many open files] I/O またはソケット例外が表示されます。JVM は常に NFS 
マウント ドライブ上のファイルを開こうとして、失敗し、1024 のファイル記述子制限に達するまで試

行し続けます。対応策は次のとおりです（/tmp はローカル ディスクです。実際の tmp 領域と置き換え

てください）。

• システム設定

ローカル ディスクに、システム レベル設定が格納されていることを確認します。システム設定は 
$JAVA_HOME/.systemPrefs に格納されています（JAVA_HOME は JDK のインストール先）。こ

のディレクトリが NFS マウントである場合は、次のコマンドを実行します。

$ rm -rf $JAVA_HOME/.systemPrefs<
$ mkdir /tmp/.systemPrefs
$ ln -s /tmp/.systemPrefs $JAVA_HOME/.systemPrefs

この対応策の問題点は、$JAVA_HOME を使用しているボックスごとに、/tmp/.systemPrefs が存

在することを確認する必要がある点です。JVM をルートとして、ローカル ディスクにインストー

ルすることを推奨します。

• ユーザ設定

ホーム ディレクトリが NFS マウントの場合に、この問題が発生するときは、次のコマンドを実行

します。

$ rm -rf $HOME/.java
$ mkdir /tmp/.java.$USER
$ ln -s /tmp/.java.$USER $HOME/.java

詳細については、次の URL を参照してください。
http://developer.java.sun.com/developer/bugParade/bugs/4673298.html
http://developer.java.sun.com/developer/bugParade/bugs/4635353.html 

その他

Fabric Manager の再起動後もマップ レイアウトを保持する方法を教えて
ください

好みに合わせてマップを編成したあとにマップを「固定」して、Fabric Manager を停止して再起動し

たあとにもオブジェクトが引き続き表示されるように設定する場合は、次の手順を実行します。
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ステップ 1 マップ内のブランク領域で右クリックします。メニューが表示されます。

ステップ 2 メニューで [Layout] > [Fix All Nodes] を選択します。

スイッチは 1 台しかないのにマップには 2 つ表示されます

スイッチが 1 台しかない場合に、マップにスイッチが 2 つ表示されるときは、隣接していない VSAN
（仮想 SAN）内の 2 つのスイッチに同じドメイン ID が設定されている可能性があります。Fabric 
Manager は <vsanId><domainId> を使用してスイッチを検索するため、ファブリック検出時に、これ

らのスイッチ間にリンクが正しく割り当てられないことがあります。

この問題を回避するには、物理的に接続されたファブリック内の同じ VSAN 内のすべてのスイッチで、

一意のドメイン ID が使用されているか確認します （この作業には、ファブリック コンフィギュレー

ション チェッカを使用します）。

スイッチ内のレッド /オレンジ /点線の意味を教えてください

スイッチ内にレッドの線が表示される場合、Fabric Manger はスイッチに関して問題点を検出していま

す。[Physical Attributes] ペインで [Switches] を選択して、[Information] ペインのステータス レポート

を表示します。モジュール、ファン、電源装置に障害があるか、または装着されているにもかかわらず

オフライン状態です。

スイッチ内にオレンジの点線が表示される場合は、スイッチに関するマイナー ステータス警告を示し

ています。通常、モジュールのいずれかに問題が発生しています。問題の原因はツールチップに表示さ

れます。マウスをしばらくスイッチ上に置くと、ツールチップが表示されます。

次の表に、Fabric Manager および Device Manager のカラー設定およびツールチップ定義を示します。

表 12-1 Fabric Manager および Device Manager の色の定義

Fabric Manager の色 定義

レッドのスラッシュ SNMP を通してスイッチと通信できません。

レッドの X ファブリック スイッチの Domain 
Manager/Fabric Configuration Server リスト内の

スイッチと通信したり、このスイッチを表示する

ことができません。

Device Manager の色 定義

モード（FICON の場合は F、T、TE、U/I など）

の付いたグリーンの正方形

ポートが起動しています。

モードの付いたオレンジの正方形 トランクが不完全です。

オレンジの十字 OLS および NOS が受信されています。

ブラウンの正方形 ポートは管理上のダウン状態です。

ライト グレーの正方形 ポートを管理できません。

レッドの十字 ハードウェア障害 /ループバック診断障害 /リン

ク障害です。

レッドの正方形 その他の設定障害です。

正方形なし、またはブラックの正方形 ポートが未設定です。
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表 12-2 Device Manager ツールチップの定義

ツールチップ 定義

adminDown ポートが管理上のダウン状態です。

bitErrRTThresExceeded ビット エラー レートが高すぎます。

bundleMisCfg PortChannel メンバーシップで設定エラーが検出

されました。

channelAdminDown このポートは PortChannel のメンバーであり、こ

の PortChannel が管理上のダウン状態です。

channelConfigurationInProgress このポートは PortChannel の設定中です。

channelOperSuspended このポートは PortChannel のメンバーであり、動

作パラメータは PortChannel パラメータと互換性

がありません。

deniedDueToPortBinding ポート バインディングにより中断中です。

domainAddrAssignFailureIsolation 選択された主要スイッチがドメイン アドレス マ
ネージャ機能を実行できないため、Nx_port のト

ラフィックをスイッチ間で転送できません。した

がって、スイッチ内のすべての 
Interconnect_Ports が隔離されます。

domainInvalidRCFReceived 無効な Reconfigure Fabric（RCF）が受信されま

した。

domainManagerDisabled ドメイン マネージャがディセーブルです。

domainMaxReTxFailure 再試行を最大限に行っても、ドメイン マネー

ジャに障害が発生します。

domainOtherSideEportIsolation ピア E ポートが隔離されています。

domainOverlapIsolation 2 つの既存ファブリックを接続する際に、ドメイ

ンが重複しています。

elpFailureClassFParamErr クラス F パラメータ エラーによる ELP 障害のた

めに隔離されています。

elpFailureClassNParamErr クラス N パラメータ エラーによる ELP 障害のた

めに隔離されています。

elpFailureInvalidFlowCTLParam 無効なフロー制御パラメータによる ELP 障害の

ために隔離されています。

elpFailureInvalidPayloadSize 無効なペイロード サイズによる ELP 障害のため

に隔離されています。

elpFailureInvalidPortName 無効なポート名による ELP 障害のために隔離さ

れています。

elpFailureInvalidSwitchName 無効なスイッチ名による ELP 障害のために隔離

されています。

elpFailureInvalidTxBBCredit 無効な B2B クレジットの伝送による ELP 障害の

ために隔離されています。

elpFailureIsolation ポート初期化中に、想定される 
Interconnect_Ports に互換性のないリンク パラ

メータが見つかりました。

elpFailureLoopbackDetected 検出されたループバックによる ELP 障害のため

に隔離されています。
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elpFailureRatovEdtovMismatch R_A_TOV または E_D_TOV の不一致による 
ELP 障害のために隔離されています。

elpFailureRevMismatch リビジョンの不一致による ELP 障害のために隔

離されています。

elpFailureUnknownFlowCTLCode 無効なフロー制御コードによる ELP 障害のため

に隔離されています。

ePortProhibited E/TE ポートに FICON 禁止マスクが設定されて

いるために、ポートがダウンしています。

eppFailure 再試行を最大限に行っても、トランク ネゴシ

エーション プロトコルに障害が発生します。

errorDisabled 管理上の対応が必要なエラー条件により、ポート

が動作していません。

escFailureIsolation Exchange Switch Capabilities（ESC）の結果、

ポート初期化中に、想定される 
Interconnect_Ports が初期化を継続できません。

fabricBindingDBMismatch  ファブリック バインディング アクティブ データ

ベースがピアと一致しません。

fabricBindingDomainInvalid ファブリック バインディング アクティブ データ

ベース内のピア ドメイン ID が無効です。

fabricBindingNoRspFromPeer ファブリック バインディングがピアからの応答

を受信しません。

fabricBindingSWWNNotFound ファブリック バインディング アクティブ データ

ベース内に、ピアのスイッチ WWN が見つかり

ません。

fcipPortAdminCfgChange 設定変更により、FCIP ポートがダウンしました。

fcipPortKeepAliveTimerExpire TCP キープアライブ タイマーの期限切れにより、

FCIP ポートがダウンしました。

fcipPortMaxReTx TCP 再送信回数が設定された制限値に到達した

ため、FCIP ポートがダウンしました。

fcipPortPersistTimerExpire TCP 持続タイマーの期限切れにより、FCIP ポー

トがダウンしました。

fcipPortSrcAdminDown 発信元イーサネット リンクが管理上のシャット

ダウンになったために、FCIP ポートがダウンし

ました。

fcipPortSrcLinkDown イーサネット リンクのダウンにより、FCIP ポー

トがダウンしました。

fcipSrcModuleNotOnline 発信元モジュールがオンラインでないため、

FCIP ポートがダウンしました。

fcipSrcPortRemoved 送信元ポートが削除されたため、FCIP ポートが

ダウンしました。

fcotChksumErr FSP SPROM チェックサム エラーが発生しまし

た。

fcotNotPresent SFP（GBIC）が搭載されていません。

表 12-2 Device Manager ツールチップの定義 （続き）

ツールチップ 定義
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fcotVendorNotSupported FSP（GBIC）ベンダーがサポートされていませ

ん。

fcspAuthenfailure ファイバ チャネル セキュリティ プロトコル認証

に失敗しました。

ficonBeingEnabled FICON がイネーブル化中です。

ficonNoPortnumber FICON ポート番号が設定されていません。

ficonNotEnabled FICON がイネーブル化されていません。

ficonVsanDown FICON VSAN がダウンしています。

firstPortNotUp 加入過多型ライン カードで、グループ内の他の

ポートが起動している場合に、先頭ポートを E 
モードで起動することができません。

firstPortUpAsEport 加入過多型ライン カードで、グループ内の先頭

ポートが E モードで起動している場合に、この

グループ内の他のポートを起動できません。

hwFailure ハードウェア障害です。

incomAdminRxBBCreditPerBuf 管理ポート rxbbcredit、パフォーマンス バッファ

に互換性がないために、ディセーブルです。

incompatibleAdminMode ポート管理モードとポート機能に互換性がありま

せん。

incompatibleAdminRxBBCredit 受信 BB クレジットに互換性がありません。

incompatibleAdminRxBufferSize 受信バッファ サイズに互換性がありません。

incompatibleadminSpeed ポート速度とポート機能に互換性がありません。

initializing ポートが初期化中です。

interfaceRemoved インターフェイスの削除中です。

invalidAttachment 接続が無効です。

invalidConfig このポートのポート チャネル設定ミスです。

invalidFabricBindExh ファブリック バインディング交換が無効です。

linkFailCreditLoss 過剰なクレジット損失が示されたため、リンクに

障害が発生しました。

linkFailCreditLossB2B キューが空でないため、Link Reset（LR）動作

に失敗したときに、リンク障害が発生しました。

linkFailDebounceTimeout 再ネゴシエーションに失敗したために、リンク障

害が発生しました。

linkFailLineCardPortShutdown ポートがシャットダウンしたために、リンク障害

が発生しました。

linkFailLinkReset リンクがリセットされたために、リンク障害が発

生しました。

linkFailLIPF8Rcvd F8 LIP が受信されたために、リンク障害が発生

しました。

linkFailLIPRcvdB2B 受信キューが空でないため、Loop Initialization
（LIP）動作に失敗したときに、リンク障害が発

生しました。

表 12-2 Device Manager ツールチップの定義 （続き）

ツールチップ 定義
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linkFailLossOfSignal Loss of Signal（LOS; 信号消失）により、リンク

障害が発生しました。

linkFailLossOfSync 同期ずれにより、リンク障害が発生しました。

linkFailLRRcvdB2B 受信キューが空でないため、LR 動作に失敗した

ときに、リンク障害が発生しました。

linkFailNOSRcvd 動作しないシーケンスが受信されたため、リンク

に障害が発生しました。

linkFailOLSRcvd オフライン シーケンスが受信されたために、リ

ンク障害が発生しました。

linkFailOPNyRETB2B 受信キューが空でない場合に、オープンな基本信

号が戻されたため、リンク障害が発生しました。

linkFailOPNyTMOB2B 受信キューが空でない場合に、オープンな基本信

号がタイムアウトになったため、リンク障害が発

生しました。

linkFailPortInitFail ポートの初期化に失敗したために、リンク障害が

発生しました。

linkFailPortUnusable ポートが使用不能なために、リンク障害が発生し

ました。

linkFailRxQOverFlow 受信キューのオーバーフローにより、リンク障害

が発生しました。

linkFailTooManyINTR ポート中断が過度に発生したために、リンク障害

が発生しました。

linkFailure 物理的なリンク障害が発生しました。

loopbackDiagFailure ループバック診断障害が発生しました。

loopbackIsolation ポートが同じスイッチ内の別のポートに接続され

ています。

noCommonVsanIsolation ピアに対して共通の VSAN が存在しないため、

トランクが隔離されています。

none 障害は発生していません。

nonParticipating ループ初期化中に、ポートがループ動作に参加で

きません。

offline 物理リンクがオフライン ステート（FC-FS 標準

で定義済み）です。

ohmsExtLBTest 外部ループバック診断障害により、リンクが中断

しました。

other 原因が定義されていません。

parentDown このインターフェイスがバインドされている物理

ポートがダウンしています。

peerFCIPPortClosedConnection ピア FCIP ポートによって TCP 接続が閉じられ

たため、ポートがダウンしました。

peerFCIPPortResetConnection ピア FCIP ポートによって TCP 接続がリセット

されたため、ポートがダウンしました。

表 12-2 Device Manager ツールチップの定義 （続き）

ツールチップ 定義
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portBindFailure ポート バインド障害が発生したために、ポート

が隔離されました。

portBlocked FICON により、ポートがブロックされました。

portChannelMembersDown 動作中のメンバーがありません。

portFabricBindFailure ファブリック バインド障害が発生したために、

ポートが隔離されました。

portGracefulShutdown ポートが正常にシャットダウンしました。

portVsanMismatchIsolation 異なるポート VSAN を持つ非トランキング ポー

トを使用して、2 つのスイッチを接続しようとし

ました。

rcfInProgres 隔離された xE_port が、隔離されていない単一

ファブリックを構築するために RCF を送信し、

中断的再設定を要求しています。隔離できるのは 
Interconnect_Ports だけです。

srcPortNotBound このインターフェイスに対して送信元ポートが指

定されていません。

suspendedByMode 動作モードに互換性がないために、ポート チャ

ネルに属するポートが中断しています。

suspendedBySpeed 動作速度に互換性がないために、ポート チャネ

ルに属するポートが中断しています。

suspendedByWWN リモート sWWN に互換性がないために、ポート 
チャネルに属するポートが中断しています。

swFailure ソフトウェア障害です。

tooManyInvalidFLOGIs 無効な FLOGI が多すぎるために中断しました。

tovMismatch TOV の不一致により、リンクが隔離されました。

trunkNotFullyActive ピアと共通の VSAN の一部が起動していません。

upgradeInProgress ライン カード アップグレードが進行中です。

vsanInactive ポート VSAN が非アクティブです。ポート 
VSAN をアクティブにすると、ポートが再び動

作可能になります。

vsanMismatchIsolation トランク ポートの両側にこの VSAN が設定され

ていません。

zoneMergeFailureIsolation 2 つの Interconnect_Ports が、ゾーニングのマー

ジ要求を交換したあとに、ゾーニング設定をマー

ジできません。

zoneRemoteNoRespIsolation リモート ゾーン サーバが応答していないために、

隔離されました。

表 12-2 Device Manager ツールチップの定義 （続き）

ツールチップ 定義
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マップ設定を保持したままアップグレードする方法を教えてください

Fabric Manager のバージョンをアップグレードする場合に、マップ設定（ラック名、マップ上の位置

など）を保持できます。

MDS 9000/db ディレクトリには、各ユーザのサブフォルダ（1 つは fmserver 用）が格納されています。

これらのサブフォルダには、検出されたすべてのファブリック（*.dat）およびマップ（*.map）に関す

るファイルが格納されています。これらはバージョン間でアップグレード可能です。ファブリック 
キャッシュをクリアする必要がある場合は、まずラックをファイルにエクスポートし、これらが失われ

ないようにします。ラック以外のすべてのもの、およびマップ座標は、スイッチに格納されます。初期

設定、前回開いたときの設定、および site_ouis.txt フォーマットには、リリースによる違いがありませ

ん。

Fabric Manager Server を新規ホストに移行するときに履歴データを保持
する方法を教えてください

Fabric Manager Server を新規ホストに移行するときにデータを保持する手順は、次のとおりです。

ステップ 1 ラックをファイルにエクスポートします。

ステップ 2 Fabric Manager をインストールし直します（新しいホストにインストールする場合は、Fabric 
Manager をインストールします）。

ステップ 3 インストールしたら、Fabric Manager Server を停止します。

ステップ 4 RRD ファイルを 元のホストから新規ホストにコピーします。このファイルを MDS 9000 ディレクトリ

に格納します（Windows PC では、このディレクトリのデフォルトのインストール場所は C:¥Program 
Files¥Cisco Systems¥DCM です）。

ステップ 5 新規ホストの MDS 9000¥bin フォルダにある PMUpgrade.bat を実行します。これにより、ファイル

と新規ディレクトリ構造が作成されます。データを収集したスイッチごとに、ディレクトリが存在しま

す。

ステップ 6 特定のスイッチでデータ収集を継続するには、該当スイッチのフォルダ内の db サブフォルダを pm 
フォルダにコピーします。

ステップ 7 新規ホストで、Performance Manager Service（Windows）または Daemon（UNIX）を再起動します。

この作業には bin/PM.bat ファイルを使用します。または、Fabric Manager のメニューから [ 
Performance] > [Collector] > [Restart] を選択します。

ステップ 8 ラックの新規ホストを再度インポートします。

ステップ 9 古いホストの元のサービスは必ずオフにします。

FCIP で Fabric Manager を使用する場合の制約事項はありますか

FCIP トンネルが起動しているかぎり、Fabric Manager はこのトンネル上で制限なく機能します。ただ

し、Fabric Manager はファブリック内にある Cisco SN5428 の管理 IP アドレスを自動検出できません。

このスイッチの場合は、タイムアウト エラーが発生するため、FCIP デバイスにレッドのスラッシュが

表示されます。ただし、ネーム サーバまたは FSPF 内にターゲット、発信側、および Cisco SN5428
（または他の任意のスイッチ）に接続された ISL（スイッチ間リンク）が表示されているかぎり、この

スイッチはこれらをすべて認識します。
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この問題を解決するには、[Switches] テーブルに IP アドレスを手動で入力し、[Apply] をクリックし

ます。コミュニティ ストリングが正しい場合、レッド スラッシュは消えます。コミュニティ ストリン

グが正しくない場合でも、Cisco SN5428 をダブルクリックすると、Web ツールが起動します。

[Please insure that FM server is running on localhost] メッセージへ
の対処法を教えてください

このエラー メッセージは、ファブリックに接続できない場合、および PC に複数のネットワーク イン

ターフェイス カードが搭載されている場合に、表示されることがあります。問題として考えられるの

は、Fabric Manager が不正なインターフェイスを通して通信を試みていることです（このことを確認

するには、FMServer.log ファイルを調べます）。

通常は、起動時にインターフェイスを自動的に選択する方法が最適です。上記エラーが表示される場合

は、不正な設定が含まれている可能性があります。

Fabric Manager をリセットして、次回の起動時にインターフェイスを自動的に選択する手順は、次の

とおりです。

ステップ 1 Fabric Manager のインストール ディレクトリ内にある server.properties ファイルを開きます。

Windows プラットフォームの場合、このファイルはデフォルトで C:¥Program Files¥Cisco 
Systems¥MDS 9000 内にあります。

ステップ 2 snmp.localaddress 行をコメント化します。

ステップ 3 ファイルを保存して、終了します。

ステップ 4 Fabric Manager を再起動します。

（注） 場合によってはこの方法を使用せずに、Fabric Manager が使用するインターフェイスを手動で選択す

る必要があります。詳細については、「複数のインターフェイスを使用して Cisco Fabric Manager を実

行する方法を教えてください」（P.12-21）を参照してください。

複数のインターフェイスを使用して Cisco Fabric Manager を実行する方
法を教えてください

ご使用の PC に複数のインターフェイス（NIC）が装備されている場合は、4 つの Cisco Fabric 
Manager アプリケーションによってこれらのインターフェイスが自動的に検出されます（ループバッ

ク インターフェイスは無視されます）。Fabric Manager Client および Device Manager は、起動するた

びに PC 上のすべてのインターフェイスを検出し、ユーザはその中の 1 つを選択できます。Fabric 
Manager Server および Performance Manager は、初回インストール時にすべてのインストールを検出

し、ユーザはその中の 1 つを選択できます。これらの 2 つのアプリケーションでは、インターフェイス

の選択を求めるプロンプトは再表示されません。

使用しているインターフェイスを変更しなければならない場合があります。

例：

• Fabric Manager Server または Performance Manager をインストールしたあとに、インターフェイ

スを追加した場合

• 最初に選択したインターフェイスと異なるインターフェイスを使用する場合
12-21
Cisco Fabric Manager 基本コンフィギュレーション ガイド

OL-19777-01-J



第 12 章       管理ソフトウェアの FAQ
その他
• 何らかの理由により、いずれかの Cisco Fabric Manager アプリケーションが複数のインターフェイ

スを検出しなかった場合

インターフェイスを認識するアプリケーションに応じて、次のセクションを参照してください。

• 「Fabric Manager Server の手動によるインターフェイスの指定」（P.12-22）

• 「Fabric Manager Client または Device Manager の手動によるインターフェイスの指定」（P.12-22）

Fabric Manager Server の手動によるインターフェイスの指定

Fabric Manager Server（Performance Manager および Fabric Manager Web Services を含む）にイン

ターフェイスを指定する手順は、次のとおりです。

ステップ 1 MDS 9000 フォルダに移動します。Windows プラットフォームの場合、このフォルダはデフォルトで 
C:¥Program Files¥Cisco Systems¥MDS 9000 内にあります。

ステップ 2 テキスト エディタを使用して server.properties ファイルを編集します。

ステップ 3 snmp.localaddress 行が表示されるまでスクロールします。

ステップ 4 この行がコメント化されている場合は、コメント文字を削除します。

ステップ 5 使用する NIC の IP アドレスまたはインターフェイス名にローカル アドレス値を設定します。

ステップ 6 ファイルを保存します。

ステップ 7 Fabric Manager Server を停止して、再起動します。

Fabric Manager Client または Device Manager の手動によるインターフェイスの指定

Fabric Manager Client または Device Manager にインターフェイスを指定する手順は、次のとおりで

す。

ステップ 1 MDS 9000/bin フォルダに移動します。Windows プラットフォームの場合、このフォルダはデフォル

トで C:¥Program Files¥Cisco Systems¥MDS 9000 内にあります。

ステップ 2 DeviceManager.bat ファイルまたは FabricManager.bat ファイルを編集します。

ステップ 3 set JVMARGS= で開始する行にスクロールします。

ステップ 4 パラメータ -Device Managerds.nmsaddress= ADDRESS を追加します。ADDRESS は使用する NIC の 
IP アドレスまたはインターフェイス名です。

ステップ 5 ファイルを保存して、Fabric Manager Client または Device Manager を再起動します。

HTTP プロキシ サーバの設定方法を教えてください

ネットワークでプロキシ サーバを使用して HTTP 要求を処理する場合は、Java Web Start Application 
Manager にプロキシ サーバの IP アドレスが正しく設定されているか確認してください。

Java Web Start Application Manager にプロキシ サーバを設定する手順は、次のとおりです。

ステップ 1 Java Web Start アプリケーションを起動します。
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ステップ 2 Java WebStart Application Manager で [File] > [Preferences] を選択します。

ステップ 3 [Manual] オプション ボタンをクリックし、[HTTP Proxy] フィールドにプロキシ サーバの IP アドレス

を入力します。

ステップ 4 [HTTP Port] フィールドに、プロキシ サービスで使用する HTTP ポート番号を入力します。

ステップ 5 [OK] をクリックします。

トポロジ マップをクリアする方法を教えてください

ファブリックから削除されたスイッチがある場合は、スイッチのアイコンにレッドの X が表示されま

す。スイッチを再起動しなくても、Fabric Manager Client または Fabric Manager Server からこの情報

をクリアすることができます（Fabric Manager Server の場合は、すべてのクライアントの情報がクリ

アされます）。

Fabric Manager を使用してトポロジ マップの情報をクリアする手順は、次のとおりです。

ステップ 1 Fabric Manager の [Refresh Map] アイコンをクリックします。

クライアントから情報がクリアされます。

ステップ 2 [Server] メニューの [Purge Down Elements] をクリックします。

サーバから情報がクリアされます。

注意 現在アクセスできないすべてのデバイス（オフラインの可能性がある）が除去されます。

ソフトウェア混在環境での Fabric Manager の使い方を教えてください

Fabric Managerバージョン 2.0(x) を使用すると、Cisco MDS 9000 スイッチが混在しているファブリッ

クを管理できます。これらの機能をサポートしないソフトウェア バージョンが稼動するスイッチでは、

特定の 2.0 機能タブには何も表示されません。

Fabric Manager 起動時に「corrupted jar file」エラーが表示されます。
対処方法を教えてください

次のエラーが表示される場合： 

An error occurred while launching the application Fabric Manager.

download error:corrupted jar file at <ipaddress>¥Device Managerboot.jar

（<ipaddress> はスイッチの IP アドレス）
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表示されるエラー メッセージは、Java Web Start キャッシュが破損していることを示します。まず、

Java Web Start キャッシュをクリアしてください。キャッシュをクリアするには、（[Programs] メ
ニューから）Java Web Start を実行し、[preferences] で [clear cache] を選択します。または、すべての 
Fabric Manager または Device Manager インスタンスが閉じていることを確認してから、.javaws/cache 
を削除して、手動でキャッシュをクリアします。新しい JRE では、このディレクトリは Documents 
and Settings¥USERNAME 内に、古い JRE では Program Files¥Java Web Start 内に作成されます。

キャッシュ フォルダ内を参照して、問題となる IPAddress フォルダ（cache/http/D10.0.0.1 など）を削

除することもできます。

同様に、ホストでウィルス チェッカ /Java ブロック機能が稼動していないか確認してください。

アンインストール プログラムを実行してから、.cisco_mds ディレクトリを削除することもできます。

その後、Fabric Manager を再インストールします。

ファブリック内のデバイスの検索方法を教えてください

Fabric Manager では、pWWN などの複数の属性を使用して、1 つまたは複数のデバイスを検索できま

す。

Fabric Manager で検索する手順は、次のとおりです。

ステップ 1 マップを右クリックし、ドロップダウン メニューから [Find Elements] を選択します。

[Find Fabric] ダイアログボックスが表示されます（図 12-1 を参照）。

ステップ 2 左のドロップダウン リストから [End Device] を選択します。

ステップ 3 右のドロップダウン リストから [Port WWN] を選択します。

WWN の一部を入力してワイルドカード（*）を使用することもできます（たとえば、*fb*f8 と入力で

きます）。

図 12-1 エンド デバイスと Port WWN を選択した状態でファブリック ダイアログボックスを検索

ステップ 4 [Map] で [Find] をクリックします。
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ゾーン内のデバイスを検索するには、[Zones] で [Find] をクリックします。[Fabric] ペイン内でデバイ

スがハイライト表示されます。任意のデバイスを右クリックすると、そのデバイスの属性が表示されま

す。これらのデバイスに接続されたリンクを選択して、リンクの属性を表示することもできます。

テーブルの検索方法を教えてください

Fabric Manager では、1 つ以上の属性が割り当てられたデバイスを検索できます。[Find] ダイアログ

ボックスに検索ストリングを入力し、[Next] および [Previous] ボタンを使用して結果を移動します。

Fabric Manager のテーブル内を検索する手順は、次のとおりです。

ステップ 1 ツールバーの [Find] アイコンをクリックします。

[Find] ダイアログボックスが表示されます（図 12-2 を参照）。

図 12-2 [Find] ダイアログボックス

ステップ 2 [Find] テキストボックスに検索ストリングを入力します。

ステップ 3 [Selection] をクリックして選択した行を検索します。

ステップ 4 大文字と小文字を区別しない場合は、[Ignore Case] チェックボックスをオンにします。

ステップ 5 検索ストリングに完全に一致した結果だけ表示する場合は [Exact Match] チェックボックスをオンにし

ます。

ステップ 6 検索するには、[Next] をクリックします。

ステップ 7 ダイアログボックスを閉じるには、[Cancel] をクリックします。

Fabric Manager Server のライセンスについて教えてください

Cisco MDS 9000 ファミリ Cisco Fabric Manager Server のライセンス パッケージが提供する拡張管理

機能を使用する場合は、スイッチを管理するファブリックごとに、少なくとも 1 台のスイッチにこの

パッケージをインストールする必要があります。Performance Manager機能を使用してモニタ（履歴パ

フォーマンス モニタリング）するすべてのスイッチにも、ライセンスが必要です。すべてのスイッチ

にライセンスを取得しないと、フロー パフォーマンス モニタリングを効果的に使用できません。した

がって、Cisco Fabric Manager Server で管理する各ファブリック内のすべてのスイッチにライセンスを

取得することを推奨します。
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ライセンスをインストールする前に、Cisco Fabric Manager Server の機能を自由に試すことができま

す。ただし、これらの拡張機能は、120 日の猶予期間が過ぎると停止します。猶予期間が過ぎて、ライ

センスを保持するスイッチが存在しなくなっても、標準の Cisco Fabric Manager 設定機能および管理

機能は引き続き使用できます。

複数のファブリックの管理方法を教えてください

複数のファブリックをモニタして管理するには、1 つまたは複数のファブリックを保持する必要があり

ます。このためには、[Server] > [Admin] ダイアログボックスの [Fabric] タブで [Persist] チェック 
ボックスをオンにします。SAN-OS Release 1.3.x 以降が稼動するスイッチを両方のファブリックで使

用し、これらで同じユーザ /パスワードを使用する必要もあります。両方のファブリックを物理的に接

続しないでください。

ライセンス期限が切れるとスイッチに表示されるオレンジの X をクリアす
る方法を教えてください

ライセンス付き機能を使用している場合に、ライセンス期限が切れると、Fabric Manager はライセン

ス違反であることを示し、Fabric Manager マップ上のスイッチにオレンジの X を付加します。

ライセンス違反メッセージおよびオレンジの X をクリアするには、ホスト上で Cisco Fabric Manager 
サービスを停止し、再起動します。
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